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Overview of the Online Map

There are tabs available along the left under the map name and tools in the upper left-hand corner of the map under the search bar.

Navigating the Map

Layer List and Lavers | Legend Tab | Information | Change Basemap | Extract Lavers by Area of Interest | Filter Lavers Select
Layers by circle, rectangle, or polygon | Add Layer from ArcGIS Online, a URL or a File | Search Bar

Extract Points by Area
Legend Tab of Interest & Export
Points as a Shapefile

Layer List and Citation
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Click Arrow at the bottom of
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http://www.fs.fed.us/rmrs/people/sparkes
https://usfs.maps.arcgis.com/apps/webappviewer/index.html?id=bf3ff38068964700a1f278eb9a940dce

Navigating the Map
The initial view is the entire NorWeST Project Study Area, with the completed Production Unit polygons outlined on the map.

As you zoom in to a specific area, the stream and point layers appear. They are not initially visible.
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You can Zoom by:

1. Simply moving your mouse scroll up and down while in the window
2. Using the + and — buttons in the upper left-hand corner

You can Pan by:
Clicking on an area of the map and dragging your mouse to the desired view or using your keyboard arrow keys

Changing your Extent
You can zoom out to the initial full extent by clicking on the home butt}ﬂin the upper-left corner of the map.
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How to Use the Layer List

In the left panel of the browser window, the Layer List opens by default. You can turn layers on and off in this panel. You

can also use the arrows to expand to see the legend.


http://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST.html
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What Layers and Attributes are Displayed

To display attributes of observed stream temperature points and modeled stream temperature lines, zoom in to an area and then click
the feature you’re interested in. (Your mouse icon will not change). After you’ve clicked a point or stream location, the feature will
be highlighted and its attributes are then shown in a pop-up box. If there is more than one point/line in the same location, there
will be the ability to navigate each one by clicking the arrows in the upper-right hand corner of the window. It will take a few moments
to load all the attributes. You can see the highlighted attribute change as you navigate through the selected features.



Observed Temperature Points (points representing a thermograph location in the stream temperature database)
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e OBSPRED_ID - This is a numeric field that can be joined with a spreadsheet of summarized stream temperature observations.
e  PermaFID — Permanent Feature ID.

e SampleYear - The year that temperature data were recorded at the location.

e  GNIS_NAME- The stream name from the Geographic Names Information System database

e Source - The name of the organization that contributed the stream temperature data

The spreadsheets for all completed “Processing Units” can be found at https:

Stream Temperature (lines representing modeled streams; segments color coded by mean August temperature)

When queried, the displayed number represents the modelled temperature scenario for the selected segment. Note that the downloadable 1-km
Stream Segment Shapefile has many more modeled scenarios and years than available in this online map.

e Mean August Stream Temperature. (S1_93_11) - Historical composite scenario representing 19 year average August mean
stream temperatures (Celsius) for 1993-2011. This layer automatically turns on as you zoom in.

¢ Modeled Future Scenario 2040. (S30_2040D) - Future scenario based on global climate model ensemble averages that
represent the A1B warming trajectory for 2040s (2030 - 2059). Future stream deltas within a processing unit were based on
similar projected changes in August air temperature and stream discharge, but also accounted for differential warming of

streams by using historical temperatures to scale temperature increases so that cold streams warm less than warm streams. This
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https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/StreamTemperatureDataSummaries.shtml
https://www.fs.fed.us/rm/boise/AWAE/projects/NorWeST/ModeledStreamTemperatureScenarioMaps.shtml
https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/ModeledStreamTemperatureScenarioMaps.shtml

layer needs to be manually turned on by the user in the Layer list on the left of the map and represents temperature in degrees

Celsius.

¢ Modeled Future Scenario 2080. (532_2080D) - Future scenario based on global climate model ensemble averages that
represent the A1B warming trajectory for 2080s (2070 - 2099). Future stream deltas within a processing unit were based on
similar projected changes in August air temperature and stream discharge, but also accounted for differential warming of
streams by using historical temperatures to scale temperature increases so that cold streams warm less than warm streams. This
layer needs to be manually turned on by the user in the Layer list on the left of the map and represents temperature in degrees

Celsius.

Watersheds - Polygons representing the project “Processing Unit” Boundaries in this project. This layer turns off as you zoom in.

The processing status and HUC numbers can be found at:

Legend Tab

The legend tab shows the visible layers in the map and is automatically updated to those layers that you’ve selected in the Layer List and

is dependent on your map scale.
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Information

Clicking the Information tab on the left panel will allow you to see information about the map as well as citations for the modelled

and observed temperature.
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https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/images/NorWeST_FinalProcessingUnitsMap.jpg

Background Image

In the left panel, there is a Basemap Gallery tab. Clicking this tab allows you to change the background to your choice of
several types of basemaps. Note that you could also add your own basemap using the Add Data button.
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Extract Layer(s) by Area of Interest

Clicking the Extract Layer by Area of Interest tab brings up a geoprocessing tool that allows you to select an area of interest
using various methods. Once you’ve made your selection, you can export the points within the area(s) of interest as a
shapefile or geodatabase.

Notes:
®  You can create more than one polygon to select different areas. You can select a box around one stream and a polygon around another.
®  You can choose which layers to extract by using the check boxes next to the layer name in the left window.
e  If using a triangle, circle, or oval, the area you click and drag will be in the center of the drawn triangle, circle, or oval.
e  If using a square or rectangle, the area you click and drag will be one side of the square or rectangle.

e This tool does not select points in the attribute table. Rather, it allows the points within your area(s) of interest to be exported to a shapefile or
geodatabase. To select points to view in the attribute table, use the Select Point tool.

To remove the polygons you’ve created, click the ‘delete’ trashcan icon.

Extract Data by Ares of Interest
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Once you’ve selected your area(s), click the “Execute” button. Depending on the size of your browser window, you may need
to scroll down to see the button.



Area of Intereat™
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Choose to download as a
shapefile or a geodatabase.
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Feature Format™

Shapefile - SHP - shp <

Click to execute extraction
Helo

After a few moments, the Output tab will be a link to an output zip file containing a shapefile with your selected features. This
shapefile includes the metadata in an XML file. Please note that the points in the map are in WGS 1984 and may need to be projected.
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Click the output zip file to

Output Zip Fila download the extracted feature.
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Some Internet Explorer browsers have issues with the geoprocessing widget that allows
users to extract data. Aol boxes are not shown, but work. You can use the graphic Area of Interest™
above to choose or the other work-around is to use Chrome or Firefox to extract data.
See this ESRI page for more information.
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http://support.esri.com/bugs/nimbus/QlVHLTAwMDEwMzQ4MA==

Filter

The Filter button allows you to filter the points or segments on the map and in the attribute table by model

results.

After clicking the Filter button, use the drop-down boxes to make your choice(s). You can filter by choosing a stream name
(GNIS_NAME) of observed stream temperature point locations or Stream temperature ranges by model layer. See the layer

information section for notes on the layers and attributes.

You can build custom filters using the Options in the attribute table. See example.

T Obearved Temperature Pointz

GMIS_MAME iz

Apply

Y Mean August Stresm Tempsratura (51: 1993-2011)

Historic Temperature - 51 iz lesz than

Hiztoric Temperature - 51 iz greater than

Apply

T 2040 A1E Futurs Scenario (530)

2040 - Scenario 300 iz leas than

2040 - Scenaric 30D iz greater than

Apply

T 2020 A1E Futurs Scenario (532)

2080 - Scenario 320 iz lzaz than

2080 - Scenario 320 iz greater than

Apply

Once you’ve chosen your filter, click the Apply button. The results will show in the map and in the attribute table.
To remove the filter, click the green check mark in the upper right-hand corner of the Filter window.

T Obssrved Tempsraturs Foint: (]

GNIS_MAME is

Salmon River

Apply



If you would like to zoom to the points/segments you’ve selected:
1. Open the attribute table by clicking the arrow at the = Cbzerved Temperatre Painta | Jfzan August Spfam Temperature (57: 1993-2011)

bottom of the map %8 Options + | Alter by map extent | Q Zoomto Clear selection (¥ Refresh
2. Untoggle the “Filter by map extent” button OBSPRED_ID PERMA_FID
3. Select the point(s) or segment(s) by clicking the gray oo e

area to the left of the row(s)
4. Click “Zoom to” button

Select Layers by circle, rectangle, or polygon

Choose the “Select” button in the upper left-hand corner of the map. This tool allows you to choose up to 1000
specific points or segments on the map. You can select the points or segments from those visible on the map
by a rectangle, a polygon, or a circle. Note that the default layers are those selected in the Laver List tab.

You can use it in conjunction with the Filter tool or you can zoom in and select points in a general area. You can view the
selected points in the attribute table, and even export to a CSV file from there.

Please note that this selection tool doesn’t allow export to a shapefile. It also does not allow for you to select more than one

area. For those options, please see the Extract Layers by Area of Interest button.

p 3] 8. 2L ,‘l'?j Select I Clear

Obeerved Temperature Paoints

~f| 2040 A1B Future Scenario (S30)

Use the “Select” dropdown to change your options of “Select by rectangle”, “Select by polygon” and “Select by circle”. Select
by Rectangle and Select by Circle draw those shapes for you. Select by Polygon requires that you draw your polygon boundary
and you will need to click the map to start that polygon.
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You can clear your selection by clicking the “Clear” button in the upper right-hand corner of the Select window. If you have
already closed the window, you can click the Select button again to open the window and clear the selection.

After a moment, the points atre selected. Once they are available, you can see the number of selected records for the layer.

Click the ellipsis (...) to see your options for each layer.
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Seve to My Content

View in Attributs Table

7 Cleer eslection

Add Layer from ArcGIS Online, a URL, or a file

data in 1) ArcGIS online or 2) you can enter a specific URL if you already have a web service link or a KML
tile, GeoRSS File or CSV file URL. 3) You can also upload a file from your computer. It supports shapefiles in Zip format,
and CSV, GPX and GeoSON files.

Choosing the Add Data button allows you to add other online layers to this map. You can search the available
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Search URL File

ArcGIS Onling - Q

()'.‘-a'i:h-r mapg. ... Type * Relevance w

World Transportation

ADD  DETAILS

World Boundaries and Places

ADD ETAILS

World Topographic Map
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Search URL File

An ArcGIS Server Web Service
A WMS OGC Web Service
A KML File
A GeoRSS File

A CSV File

Click the icon oto only search layers
within the map area. Clicking it turns the
icon red so you can search all layers in the
scope.

Click the sort icon = to refine the type of
search layer and sort the items.

e Click the Type drop-down list to
search layers based on map service,
feature service, image service, vector
tile service, KML, or WMS.

e Click the Sort By drop-down list to
sort items by relevance, title, owner,
rating, view, or date.

To add layers by URL, click the URL
tab next to the Search tab. Choose a
type and enter the URL. Click Add to
add the data to the map. The added
layer will appear in the Layer List
widget as well. The following types are
supported through the URL:

e ArcGIS Server web service
e  WMS OGC web service

o KML
e GeoRSS
e CSV

11



Add Data *®

searnch UJRL File

+*| Generalize features for web display

EROWSE

Click the File tab to upload files locally.
You can either drag and drop the file
or browse to it. It supports shapefiles
in Zip format, and CSV, GPX and
GeoJSON files.

Click the X in the upper right of the Add Data window to close it and see your added layers.

To remove layers added click LAYERS in the lower right corner of the Add Data window. In the Layers panel, click the

trash can icon next to the layer to remove it.

Click BACK in the lower right corner to return to the main Add Data panel.

Search Bar

Search Bar e 2

Search for a stream by NHD Plus version 2 GNIS_NAME. Type your search and hit ‘enter’, or click the magnifying glass.

Searches take a moment and return up to 500 results. You can use this tool if you are not certain geographically where a stream or

watershed is located. It will automatically zoom to the first result, but the search bar will have a slider to search for other results. Click

another result and the map will zoom or pan to that location.

salmaon

x|2]

‘White Salmon Creek
White Salmeon Creek
‘White Salmon Creek
White Salmeon Creek
Salmon Cre=k

Salmon Creek

Salmon Cre=k

Salmon Creek

South Fork Salmon Creek
South Fork Salmon Creek
South Fork Salmon Creek
South Fork Salmon Creek

-
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Filter using attribute table example

Click on the arrow at the bottom of the map to open the attribute table

Click the Options tab in the upper left-hand corner of the table and choose the Filter option
Observed Temperature Pointz " Mean

32 Options + | Filter by map extent |

Show selected records
Show related records
1Y Filter

| Show'Hide columns
& Export all to CSVv

Please note that you can toggle the ‘Filter by map extent’ off and on. This will change your filter results.

In the Filter window, click “Add a filter expression” and then use the dropdown to choose GNIS_Name (String). You have several options. For
example, you can choose “contains” and type the name of a river. This will result in all rivers containing part of that name, including the north and
south forks. You can also use “is” and click the “Unique” radio button to get all unique values.

Filtar b4
@ Addan exnressic@set
GNIS_NAME (String |v contains . | =almon| o
®Valus Field Unique

[ ] Caze zensitive

OR

Filer

© Addanexpression @ Addaset

GNIS_MNAME (Sring |~ | s -

1918 Creek
Abalobadizh Creek
Abbot Creek
Abbott Creek
Abemethy Cresk
Abiqua Creek

Abo Arroyo
Abramsz Cresk
Achelth Creek
Ackerman Cresk
Adair Creek
Adama Cresk
Addition Creek
Aden Cresk
Advent Cresk
Aeneas Creek
Agats Cresk
Agency Cresk
Agua Blanca Cresk
Agus Chiquita Cresk

[T

Ahtanum Cresk
Aikenz Cresk

Alzmeda Creek
Alzmizos Creek
Alamosa River

Alzmosito Cresk
Albart Cresk
Albing Cresk
Albion River
Alckes Crask 7



After a moment, click the dropdown. It will be populated with the available GNIS_NAME attributes. Choose your desired stream

name and click “OK”.

Both the map and the attribute table will show only the points with those stream names. You can click to the left of the first record in

the table, move the slider bar along the right all the way to the bottom of the filtered attributes, and then click the shift key and select
the last record. This will select all the points you have filtered.

Note that your mouse will change from an arrow to a pointing hand when selecting.

2 2 Liser Cresk

2 ol Harvwy Crawl

i

£l

gy LS g

Once you have selected all the points you wish to export, Click the Options tab in the upper left-hand corner of the table and choose

the

Export Selected to CSV option.

Observed Temperature Points | Mean

T
[+

Filter

Show'Hide columns

-,

Export all to T3V

You will be prompted to confirm that you want to export to a CSV file. Click OK.

Export ta C5V

Export data 1o CSV file?

You then have the option to Open or Save the file. Click OK.

Opening Observed Temperature Points.csv

===

You have chosen to open:

i] Observed Temperature Points.csv

which is: Microsoft Excel Comma Separated Values File (736 bytes)

from: blob:
What should Firefox do with this file?

() Openwith | Microsoft Excel (default]

@) | Save File

[T Do this automatically for files like this from now on. |

ok || concel |

QK

Cancel
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Please note that there is no automatic download of the metadata with the table as there is when you download or extract layers using
the area of interest selection tool and export as a shapefile or geodatabase. You can find a general metadata document for data and
scenarios on the NorWeST website.

To remove the filter, click the X to the right of the filter expression.
Filtar X

INIS_MAME (String) is not @

Civalue Field @ Unique

Website Navigation and Citation

eled Stream Temperatures Website | User Guide

https:/ /www.fs.fed.us/rm/boise /AWAE /projects/NorWeST . html

Note that you can return to
the NorWeST website by
clicking on the link in the
upper right-hand corner

Isaak, Daniel J.; Luce, Charles H.; Rieman, Bruce E.; Nagel, David E.; Peterson, Erin E.; Horan, Dona L.; Parkes, Sharon; Chandler, Gwynne

L. 2010. Effects of climate change and wildfire on stream temperatures and salmonid thermal habitat in a mountain river network. Ecological
Applications. 20(5): 1350-1371.

Isaak, D., S. Wenger, E. Peterson, J. Ver Hoef, D. Nagel, C. Luce, S. Hostetler, J. Dunham, B. Roper, S. Wollrab, G. Chandler, D. Horan, S. Parkes-

Payne. 2017. The NorWeST summer stream temperature model and scenarios for the western U.S.: A crowd-sourced database and new geospatial

tools foster a user community and predict broad climate warming of rivers and streams. Water Resources Research. DOI: 10.1002/2017WR020969.

Data Summaries Website with data (Excel spreadsheets)
https://www.fs.fed.us/rm/boise/AWAE /projects/NorWeST /StreamTemperatureDataSummaries.shtml

Citation to use with these data summaries: Chandler, G.L.; Wollrab, S.P.; Horan, D. L.; Nagel, D. E.; Parkes, S.L.; Isaak, D.].; Horan, D.L;
Wenger, S.J.; Peterson, E.E.; Ver Hoef, ].M.; Hostetler, S.W.; Luce, C.H.; Dunham, J.B.; Kershner, J.LI..; Roper, B.B. 2016. NorWeST stream
temperature data summaries for the western U.S. Fort Collins, CO: Forest Service Research Data Archive. https://doi.org/10.2737/RIDS-2016-
0032.

Modeled Stream Temperature webpage with shapefiles, PDF maps, Model Prediction Accuracy and GIS layers by production unit:
https://www.fs.fed.us/rm/boise/AWAE /projects/NorWeST/ModeledStreamTemperatureScenarioMaps.shtml

Citation to use with these scenarios: Isaak, D.].; Wenger, S.J.; Peterson, E.E.; Ver Hoef, ].M.; Hostetler, S.W.; Luce, C.H.; Dunham, ].B.;
Kershner, J.I..;; Roper, B.B.; Nagel, D.E.; Chandler, G.L.; Wollrab, S.P.; Parkes, S.I..; Horan, D.L. 2016. NorWeST modeled summer stream
temperature scenarios for the western U.S. Fort Collins, CO: Forest Service Research Data Archive. https://doi.org/10.2737/RDS-2016-0033.
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https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST.html
http://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST.html
http://www.treesearch.fs.fed.us/pubs/35471
https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/downloads/publications/NorWeST-stream-temperature-model-scenarios_croud-sourced-database-geospatial-tools.pdf
https://www.fs.fed.us/rm/boise/AWAE/projects/NorWeST/downloads/publications/NorWeST-stream-temperature-model-scenarios_croud-sourced-database-geospatial-tools.pdf
https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/StreamTemperatureDataSummaries.shtml
https://doi.org/10.2737/RDS-2016-0032
https://doi.org/10.2737/RDS-2016-0032
https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST/ModeledStreamTemperatureScenarioMaps.shtml
https://doi.org/10.2737/RDS-2016-0033

